MICROSOFT OUTLOOK

MICROSOFT OUTLOOK COURSE DESCRIPTION

The key to a success in any business is how well you manage your communications with the
various individuals or groups. Microsoft Outlook is THE most popular software for executing
and managing emails, contacts, calendars and more. This course will cover a quick overview of
all the tools incorporated into Outlook, and then move on to topics chosen specifically for large
organizations. Included will be: creating efficient folders to save emails in Outlook; Attaching
files to Outlook emails; creating/managing contacts and groups for reference and email use;
entering appointments and scheduling meetings into Outlook calendar (including sending
invitations); setting appointment reminders; using shared/group calendars in Outlook.

This, and other handouts, are available at: https://www.clearcutcomputing.com/school

Course Contents:

1. Outlook Environment
a. Normal start screen vs Inbox start screen
b. Reading Pane
c. Organize email by creating folders
2. Email
a. Reading
Reply vs Reply to All
Forward
Email editor

b
C
d
e. Read Receipts & Delivery Receipts
f. Scheduling when an email will be sent
g. Email options
h. Signature files

i. Email rules & color coding
3. Calendar

a. Creating appointments

b. Recurring appointments

c. Reminders
4. Contacts (Address Book)

a. Creating contacts

b. Contact Groups

c. Others...
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MICROSOFT OUTLOOK

1) Outlook Environment

“QOutlook Today” Initial Outlook screen
(Bypasses Inbox)

Outlook Today - Outlook

Send/Receive  Folder  View  Q Tell me whatyou want
= y._\':l Ignore Meeting Eﬂ Search People
L Clean Up M ET Team Email EE Address Book
New New Delete Archive | Reply Reply Forward Move Rules OneMote | Unread/ Categorize Follow Send/Receive
Email ftems = | & Junk~ . More F CreateNew - Read Up Filter Email All Folders
New Delete Respond Quick Steps 5 Move Tags Find Send/Receive -~
4 Favorites < Thursday, March 31, 2016 Customize Outiock Today ...
Inbox 3819
Calendar Tasks Hessages
Sent ltems
e — Friday [ peint Ducksbaseball.org to new web host (4/1/2015) Inbox 3813
» 500 A4 1200 PV EXCEL Intermediate @Winthrop (131 Main Street, Mineola, NY 11501) Drafts o
Outbox 0
Monday
4 paulj@clearcutcomputing.c... A4 - 40021 NY Therapy -OL Training
4 Inbox 3819
4 Personal
KofC 18
Saved Mail
Drafts
Sent ltems
Deleted ltems 480
Junk E-mail [187]
Outbox
RSS Feeds
Search Folders
= @ Y e
Done [0 e

Send / Receive

Folder

Q

View

Inbox - paulj@clearcutcomputing.com - Outlook

Tell me what you want to do

= o T Ignore x D f:\4 (E ’\1 E:” E2 Meeting %1 kofc ©, To Manager ¥ @ f B | Search People mljl
N :u 18 Clean Ve~ Delk Arch Reply R \6 Fe 9&1 Qj\M' E Tearn Email ¥/ Done 1% Rules OneN Ui d/f C: ize Foll e S d‘/R
ew  New elete Archive | Reply Reply Forwar ove Rules OneNote | Unread/ Categorize Follow end/Receive
Email tems~ & Junk~ Al EliMorer 5% Reply Guelete ¥ Create New - Resd - ' Fiter Email = Al Folders
New Delete Respona Quick steps ) WMove Tags Find Send/Receive -~
4 Favorites. ¢ [Search Current Mailbox . O | Current Mailbax_~ ¢ RaReply Al €} Forward G5IM
LEBERAE) All Unread ByDste = Hewest & = aul ). Montenero <paulj@clearcutcomputing com > info@kofe2204.0rg 5:03 PM
Sent It . .
ent ftems. Power Printing and ... APRIL Issue of the Mariner
Deleted Ite 480 3 :
eleted ftems Re: Aprilissue of Mariner 1. 523 PM Click here to download pictures. To help protect your privacy, Outlack prevented automatic download of some pictures in this message.
They are actually already P PP yeurprivacy, P P 9 v
4 paulj@clearcutcomputing.co... AVG CloudCare =
4 Inbox 3819 1042 Collision Repairs - The... 5:19 PM The currrent issue of The Mariner for Knights of Columbus St. Kilian Council #2204 has just been published on our
An AVG CloudCare website. Click this link to go to the page where the current issue, and past issues, are available:
4 Personal
Angie’s List _—
KofC 18 Angg\e‘i List Business News. 5:42 PM hittp:/furww.kofc2204.0rg /! /marin
Saved Mail Browser view
IF THE LINK ABOVE DOES NOT WORK, FOLLOW THESE INSTRUCTIONS:
Ot Internet Mail Delivery i 1- Use your web browser ta visit www.kofc2204.0rg
Sent Items ?h“""”y Nﬂ““'l‘(:t'”t”‘ Delive... 5:03 PM 2- In the menu, click "Mariner Newsletter"
is report relates to a .
Deleted ltems 480 i— ZTTI dn‘,whn :nd yl}ustshnuld Steheil‘ \Itrlktlcv ﬁl\/e‘w \Ssube Utr;‘the Ma”tnrﬂ for the last 6+ years.
- Click on the top-most one In the ist, it will always be the current issue
Junk E-mail [187] Pl b
APRIL Issue of the Mariner 503 PM
Outbosx The current issue of The With these instructions, you can get any issue of the Mariner listed. You do need Adobe Acrobat Reader, 2 free program from :
https://get.adobe.com/reader;
RSS Feeds Motarola
SEEcche How to get Moto 360 (1st . 422 Pm If you know of 3 brother Knight or sister Columbiette who did not choose how they want the mariner delivered to them, please
forward this email to them and fill out the form on this same page of our website. If they have no access to the Internet,
IT Solution Journal complete the form for them. Keep in mind that we are looking to cut costs, so please encourage the email delivery method.
NASA Tech Briefs: Free Ma... 255 PM
(NOTE: The entire email list was hidden ta protect all from spammers).
Anthony Gentile
Signposts Meeting Monda... 253 PM Regards,
Signposts Meeting this Paul]. Mantenero
L Mariner Editor
= s B e DOT - NY-Alert KofC #2204 -
HRNATE: LIBNATE: 143 111 220 001 he
Items: 3,847  Unread: 3,819 o & - 1 + 1009
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The “reading pane” can be changed:

- =

File Home  Send/Receive  Folder Q Tell me whatyou want to do
~ ~ I
(_) ,d? [T Show as Conversations E‘ﬂ 2 Date €2 From 5810 i Categories 1L Reverse Sort E et Fr'
— = - |t Add Columns o= [} ]
Change View Reset Conversstion Settings - | Message | 1™ Fiag: Start Date ™ Flag: Due Date 1H Size B subject - Folder Reading To-Do  People  Reminders Openin New Close
View = Settings View N Preview ~ - - | #= Bxpand/Collapse~ | pane- | Paner Bar~  Paner Window  Window Al ltems
Current View Messages Arrangement eople... Window ~
4 Favorites ¢ Search Current Mailbox [.. 0 | Current Mailbox ~ €3 Reply {2 Reply All (£} Forward G5 IM
LEmEsE) All Unread ByDate = Newest + Paul J. Montenero <paulj@clearcutcomputing.com: ot irg 5:03 PM
Sent It . .
et ftems 4 Today APRIL Issue of the Mariner Optiops...
Deleted Items 480
ceiediiems Power Printing and Click here to download pictures. To help protect your privacy, Outlook prevented automatic dewnload of some pictures in this message.
g P P p your privacy, P P g v
Re: April issue of Mariner f... 5:23 PM
4 paulj@clearcutcomputing.co.. They are actually already Y
T AVG CloudCare The currrent issue of The Mariner for Knights of Calumbus St. Kilian Council #2204 has just been published an our
1042 Collision Repairs - The. 519 PM website, Click this link to go to the page where the current issue, and past issues, are available:
ocean An AVG CloudCare
KofC 18 hittp://www.kefc2204.org/index.php/marin
Saved Mail Angie’s List
aved Mai : X
;"9‘5 s List Business News... 542 PM IF THE LINK ABOVE DOES NOT WORK, FOLLOW THESE INSTRUCTIONS:
rowser view
Uit : ! 1- Use your web browser to visit www.kofc2204.0rg
Sent Items Internet Mail Delivery ] 2-In the menu, click "Mariner Newsletter”
Deleted ltems 480 Delivery Notification: Delive... 5:03 PM 3- scroll down and you should see a link to every issue on the Mariner for the last 6+ years.
This report relates to a 4- Click on the top-most one in the list, it will always be the current issue
Junk E-mail [187]
Outbox Paul J. Mentenero With these instructions, you can get any issue of the Mariner listed. You do need Adobe Acrabat Reader, a free program from :
APRIL Issue of the Mariner 5:03 PM https: at.adobe.com/reader,
RSS Feeds The curmrent issue of The LA -
Seaicblichasr Motorola If you know of  brother Knight or sister Columbiette who did not choose how they want the mariner delivered to them, please
How to get Moto 360 (1st .. 422 PM forward this email to them and fill out the form on this same page of our website. If they have no access to the Internet,
camplete the form for them. Keep in mind that we are looking to cut costs, so please encaurage the email delivery method.
IT Solution Journal . - .
| A e o - (NOTE: The entire email list was hidden to protect all from spammers).
Regards,
Anthony Gentile Paul 1. Montenero
Signposts Meeting Monda... 253 PM Mariner Editor
= P ~ Signposts Meeting this KofC #2204 -
'
Items: 3,847  Unread: 3,819 o B - 1 + 1009

MICROSOFT OUTLOOK

Inbox - paufj@clearcutcomputing.com - Outlook

Home

View

Q Tell me what you want to do

Creating Folders — Organizing Mail

1 A 7% Clean Up Folder -
New hew Seanch | Rename NE%” RF{. Shfwlm 6K, Delete Al Many people create multiple folders in
Foder | Felder R e e s toz S Outlook to organize the mail they want to
+Favorites © [———— keep. For example, a sales person might
i 4 want a separate folder for every customer
Deleted ltems 480 Folder contains: clid they have'
Mail and Post ltems v
jﬁ:f‘f;‘jaf‘““"m"“ﬁ“‘-"“’“ R —— w| The easiest way to do this is to right-click
+Persona Y S **| on the folder, in the tree, where you wish
KoiC 18 & sentems mel to create a sub-folder, and choose “New
e E;'TZ:""' - i Folder.” Type the name you want in the
Sent fems 2 Journal -n| box and hit the Enter key.
Deleted ltems 480 e :J‘:]';::'"'a” e zf
Junk E-mail [187] =1 Dutbox A )
e et |1 Alternatively, click the Folder tab, and

then click New Folder. Type in the name

you wish to label the folder and make sure you have clicked on the folder you want the new
folder to be under (a branch of the tree). Then click OK.

To file messages into these folders, you simply drag the messages into the folders or use the
Move button on the toolbar (to the right of the print icon).
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MICROSOFT OUTLOOK

CREATE-A-NEW-E-MAIL-q

E-mail-is-designed-to-mimic-a-traditional-written-business-letter..-Let’s-look-at-the-mapping-
below-of*the-components-of-a-business-letter-to-an-e-mail-composition-screen.c

Who-the-e-mail-is-from-
From: Paul Montenemn

and-the-date-are- | —T PO Box 369
automatically-inserted- \\\ Famningdale, MY 11735

mto-the-e-mail. = =~ april 1,200

To: lgnatz Schmurtz

One Education Drive
Garden City, NY 11530
...... Subject: E-Mail Class
Dear lgnatz:
The only way to become fluent in the use of e-mail is to do it every day! Try
to tum on your e-mail program at e start of each day and send a message
or two 10 fiends or 2 co-worker.
Sincerely,
PaulJ. Montenero
— ATTACHMENT
____________________________ — CC:  Joe Smith
r Sue Jores
! [rrom »\ BCC:  Nassau Cornmunity College
|
|
I
b
| i =
. K
| .
i I Message
: - i (Bod - Ja al== | . za} &% " [ Follow up - |
I I Calibri (Bod = |11 A A - = -, i ?t.:-\;‘. | | / 1/ High mportyce L_*..
. ! Paste _ B I U - A- ':__-I = 3 Address Check Attach Signature ) Immersive
I ¥ Format Painter = Book Mames  File - = + Low Imporfance Reader
. Chpboarﬂ ] Basic Text ] Names Inchucle Tags M Imfmersive
|
i I . From ™™ pauy@dlearcutcon
T Ta.
N I
— e — - B
i -
1 2 [ PP 4 5 . [ 7 L]
1
4
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MICROSOFT OUTLOOK

2) Email

Writing a New Message (eMail)

To: primary people the message is for.

CC: “carbon copy” —people who should know about the email conversation;
everyone who receives the email will see the people on the “TO” list and the
“CC” list.

BCC  “blind carbon copy” —people who see the email and everyone in the “TO”
and “CC” list; but nobody will see the list of people in the “BCC” list.

Untitled - Message (HTML)

Message Insert Options Format Text Review Q Tell me what you want to do
ol C e szl o2 h g -
o Calibri Boc = |11 | A A |IE -] 4 |..6= % mJ i _‘2 [> Follow Up
0 Copy e Check | Attach Attach Si I High Importance
aste akr _ - BE==| e = ress ec ttacl ttac ignature
- ~ Format Painter B I U |®-A = 7 7" 7 Book Mames File= ltem~ - ¥ Low Importance
Clipboard ) Basic Text (] Names Include Tags ) LS
To..
=1
Ce...
Send
Bre...
Subject

| am testing email addresses. Please reply to this e}nail.

Regards,

Paul J. Montenero

President

Clear-Cut Computing Corp.

PC Box 369, Farmingdale, NY 11735

Tel: 516-845-4081 ext 1 — Fax: 516-945-0851

Popular Email Options — on the Options tab, are choices for:
e Requesting a “Read Receipt” and “Delivery Receipt.”
e “Delaying Delivery” (or scheduling when an email will be sent).

Untitled - Message (HTML}

Message  Insert FormatText  Review  Q Tell me what you want to do
j [ Colors - B =« 00 i ] L I ®
& & —
Fonte- 85‘(- 3% | Request a Delivery Receipt Q‘ g %
Themes - age Bcc  From Use Voting Request a Read Receipt Save Sent Delay  Direct
- (D Bffects ) Buttons - Item To - Delivery Replies To
Themes Show Fields Permission Tracking ) More Options ] A
To,.. ||
=1
Cc.
Send
Beo.
Subject
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MICROSOFT OUTLOOK

Click the File tab and then choose Options to get to the many customizable settings
you have available to you in Outlook. Clicking Mail, on the left brings up the window
below.

Qutlock Options ? X
General o . =
ifi Change the settings for messages you create and receive.
Mail
Calendar Compose messages
People & . 5
= Change the editing settings for messages. Editor Options...
Tasks Compose messages in this format: | HTML -
Search
ABC 77 Always check spelling before sendi :
Language Always check spelling before sending Spelling and Autocorrect...
Advanced | Ignore original message text in reply or forward
Custernize Ribbon N
4? Create or modify signatures for messages. Signatures...
Quick Access Toolbar
Add-ins B
AC Use stationery to change default fonts and styles, colors, and backgrounds. Stationery and Fonts...

Trust Center

Outlook panes

Customize how items are marked as read when using the Reading Pane. .
I% Reading Pane...

Message arrival

"__ i When new messages arrive:
IJ 7] Play a sound

Briefly change the mouse pointer
/| Show an envelope icon in the taskbar
| Display a Desktop Alert

Enable preview for Rights Protected messages (May impact performance)

Conversation Clean Up .

0K Cancel

Authoring your emails in HTML format (changing font colors, sizes, bold) can be
done if you set the “email editor” to Microsoft Word (done on the Tools---Options
menu choice; then click the Mail Format tab).

Also on this screen are the controls for setting your “Signature.” Signatures are text
that can appear at the bottom of new mail you write or replies. This saves you time as
you can save a lot of info in one signature.

Signatures and Stationery ? X

E-mail Signature  Personal Stationery

Select signature to edit Choaose default signature
PIM-LT Sig E-mail account: | ooy i@ clearcutcomputing.com ~
PIM-LT Sig-short
Mew messages: PIM-LT Sig w
Replies/forwards: | pjpq.1 sig-short w
Delete Mew SAVE Rename
Edit signature
Calibri “1elle 1 u Avtematic  |v|||= = = | & pusiness card |L_‘.;. =
Regards, ~
Paul . Montenero
President

Clear-Cut Computing Corp.

PO Box 363, Farmingdale, NY 11735

Tel: 516-845-4081 ext 1 —— Fax: 516-545-0851
E-mail: paulj@clearcutcomputing.com
===Be Sure To Visit Our Website At:

=== www.clearcutcomputing.com

Cancel
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MICROSOFT OUTLOOK

Email Rules
On the Home tab, click Rules. The two choices at the bottom of that menu are the

most important:
Create Rules — allows simple rules to be created (shown below).

Manage Rules & Alerts — for more co

Send/Receive  Folder  View Q@ Tell me what you wantto do
= |__\'-j T Ignore x D &) E:ﬂ E:’] 2 Meeting | [ kofc 3 To Manager Vi I%ﬂ Eij [ B> |[Search People =5
N ‘N' % Clean Up~ Do Arch E(" . (" 5 ')d GS5m- [ Team Email + Done " Rllj D-)N e € ol [E: Address Book 5 d’/R
ew  New clete Archive Reply Reply Forwar ~ Move Rules OneNote Unread/ Categorize Follow end/Receive
Email Items+ | 4 Junk~ Al FMore- | Reply &uDelete ¥ Create New M - Read : Y Fiter Email~ A\l Folders
New Delete Respond Quick Steps 5 Move Tags Find Send/Receive ~
4 Favorit( - ]
Inbox 38 = B
st When | get e-mail with all of the selected conditions I = choose atolder gero g8 P
ent lterr L
B e e v [FZ) pauj@dearcuteamputing.com " oK other server
Deleted | v Inbox (3832)
[ Subject contains | [Liquid Web] Re: Point “website® to anather server Liquidweb Cancer | ¥ Outlook prevented automatic download of same pictures in this message. -
4 [Jsentto | Paul Montenera ~ Personal
4 paulj@ Saved Mail New. =
4 Inbox 3 Do thefollowing 7 Drafts [1]
[ Display in the New ftem Alert window 7 Sent flems
Liquidy BEY 1= Deleted ltems (431}
aperson,  LIPlayaselected sound: | Windows Notify Em | b | | Browse... lj Calendar
| 5] Contats
Kofc  [FMove the item to folder: | Select Folder Select Folder.. 7 Journal
saved] (] :“m:k E-mail [198]
Bemoli oK Cancel Advanced Options... otes
ratis e 3] Outbox v for you and is being reviewed by our support staff.
Sent Items
Deleted lterme 481 | Victor Picone i To add additional comments, reply to this email. If you are a current customer, you can also visit

“Color-Coding” emails is actually known as “Conditional Formatting:”
1. From the View tab, click View Settings.
In the window that appears, choose Conditional Formatting.
On the next window, click Add and give a name to it.
Click the Font button and set how you want the messages to be displayed if the
condition(s) are met.
Click the Condition button
Fill in the information on the final window. You can be as versatile as setting
the condition to trigger if certain words are in the subject or body of the email.

paulj@clearcutcomputing.

2.
3.
4.

o o

- -

Home Send / Receive Folder Q Tell me what you want to do
& S ~, n
C) *? ["a) Show as Conversations 3 pate €2 From = I Categories +” B E L_E rr"a
- = - | =1 Add Columns
Change View Reset Conversation Settings~  Message | % Flag: start Date I* Flag: Due Date 1 size =) Subject - Folder Reading To-Do = People  Reminders Openin New Close
View - Settings View ; Preview - 7| #= Bxpand/Collapse™  pane+ Paner Barr | Paner  Window  Window Al tems
Current View Messages Arrangement Layout People... Window ~
-
% [ Con
b 3 ul &47 PM
i oo e fon i e Messages More Choices Advanced
Cal Importance, Reminder, Icon, Attachment, From, Sub e mesnges Add i
olumns.. moortance, Reminder, lcan, Attachment, From, Subject, . nread group headers Search for the wordis: TSN =
ubmitted but not sent Delete ur ge. ~
Group By. None Expired e-mail In: | subject field only ~
Overdue e-mail
4
Messages in other folders MoveUp ||, =
i ST BeceREtides e Doy ite Mailbox document pending uploa 53 From...
Voicemails Move Down
Filter... off Sent To..
Properties of selected rule
Jwnere | am: the only person on the To line
Other Settings. Fonts and other Table View settings Name: Voicemails
Fonb. 1% pt. Forts Time: | none < ||[Anytime
Conditional Formatting...  User defined fonts on each message
Condition...
Format Columns. Specify the display formats for each field ha
na
oK Cancel | [ | [ ok ] Ccancel Clear All
Reset Current View oK Cancel
Outbex | Wil opies be ready n
FSfs Kim Callahan = ¢ Joseph Clarke (Liquid Web)
Search Folders RE: Estimate 203 from Clear. 243 PM !
Hi Paul, 1just wanted to
Voicemail Sygt... ] Hello,
New voicemail in mailbox 3.., 207 M
Vou have a new message in Thank you for providing the IP. | have gone ahead and updated the site so that
PSEG Long Island the mail is still pointing here but the website is pointing to 54.208.212.1.1f
Limited time: 2 free LED bu... 2:04 PM you need anything changed or have any guestions please let us know.
Paperless billing is a bright
= as [ . - -
@ I Victor Picone ~ Thank vou
Items: 3,866 Unread: 3,832 0 @ - I + 100%
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MICROSOFT OUTLOOK

3) Calendar

From the view menu, you can choose from different views: single day, week, month.

Calendar - paulj@clearcutcomputing.

Send / Receive Folder

m REE EE EBD = B B E i e
e e 5 ] [ Address Book
New New Mew Today Met7 — Day Work Week Month Schedule ~ Open Calendar E-mail  Share  Publish  Calendar
Appointment Mecting Items - Days Week View | Calendar~ Groups~ Calendar Calendar Online - Permissions
New GoTo & Arrange 5 Manage Calendars Share Find ~
<
4 March 2016 3 . § Today Tomorrow Saturday g
4 » April3-9,2016 Washington, D.C. ~ 5 e E X 77oE/5ee § i Search Calendar (Cirl=E) o
SCITEaE e P Y T4°F/66°F TT°F/56°F 63°F/41°F
829 1 2 3 45 SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY SATURDAY
6 7 8 9 10 11 12 3 4 5 6 7 8 g
13 14 15 16 17 18 19
071 2223425 %
= A NY Therapy -OL =
27 28 29 30 |El 8 Training
= NY EXCEL Intermediate
Aprii 2016 g Therapy 5 @Winthrop
SU MO TU WE TH FR SA Dentist 131 Main Street,
Appt Mineola, NY 11501
g2 10 Paul J Montenero
345 6 7 8 9
10 11 12 13 14 15 16 11
17 18 19 20 21 2 23
2425 26 27 28 29 30 127
12 3 4 5 6 7
1
4 My Calendars
Calendar
2
3
4
- 5
= 2l
Items: 4 O =@ - 1 + 100%

NY Therapy -OL Training - Appointment

Appointment Insert Format Text Review @ Tell me what you want to do
o= 3 i
E?—-l x r‘l s E g-) El .a Show As: M Busy - O L'@' n ALER
— - &= S i I High Importance
Save & Delete Copyto My & . Appaintment Scheduling Meeting Invite Reminder: | None . Recurrence Time  Categorize
Close Calendar Motes Attendees Zones < ¥ Low Importance
Actions Show Meeting Notes  Attendees Options Tags ~
Subject NY¥ Therapy -OL Training
Location 500 Bi-County Road, Farmingdale, NY 11735 -
Starttime | Mon 4/4/2016 =] &00am N All day event
Endtime  Mon4/4/2016 5 400PM -
Outlook 2016
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4) Contacts

The view can be changed to choose from many different layouts.

Contacts - paulj@clearcutcomputing.com - Outlook

[l Sond/Receive  Folder  View  Q Tell me what you want to do

o =1 x = fh ° _ — ¥ e r (1] > Search People
i ] o iV = = [Ce s, —
o i B N - T 8= % 38 o > i [ Address Book
New New Contact New  Delete Meeting More People | BusinessC..  Card Phone ~| Move Mail OneNote Forward Share OpenShared Categorize Follow Private
Contact ~ Group  ltems~ - - Merge Contact ~ Contacts  Contacts - Up~
New Delete  Communicate Current View Actions Share Tags Find A~
4 My Contacts Search Contadts (Ctrl+E) L
[ ——— 5 ) . B Michael Buonanno
Jackie Budris
ab Presence unknown
AXA-Advisors, LLC.
cd
. Michael Buonanno @ ® M @ @ M Edit -
1
a Lois Burch CONTACT  NOTES
L] -
Calendar View Source
i Dennis & Kathleen Burns Schedule a meeting Qutlook (Contacts)
k
. Link Contacts...
| Jay Bush Send Email
o michael.bucnanno@axa-advisors.com
Company
" . - -
M&T Business Send Email AXA-Advisors, LLC.
op mikelinb@optenline.net
q ‘Work Address
Geoff & Arlene Cammar...
. Call Work 11 Marcus Avenue
(218 25595 Suite 100
s (5 52 Lake Success, NY 11042
| Richard Cantor United States of America
Wark Fax
uv P o
(516) 8
w Cantor-Pecorella
x M
y James Caporaso michael.bucnanno@axa-advisors.c
= [ = Michelle Cardillo
Items: 552 0 =@

Entering/Editing a Contact

Simply click the New button and enter the details. Outlook has a wide assortment of
fields to use to record the details of contacts you know. Use the bas along the top of
the window to see all of the fields

‘hh - = Untitled - Contact

Contact Insert Format Text Review Q Tell me what you want to do

¥ x H. [z Eﬂ ) Details s r| el 2zl =% o | [ 1] >
E 2 : i to S &= s

Ly =3 b 2 Conficates |~ HET] QY | Vo 2 i
Save & Delete Save & Forward Onehlote | General Email Meeting More Address Check | Business Picturs Cstegorize Follow Private Zoom  Start

Close New= - E AllFields o Book MNames  Card © o Up~ Inking
Actions Show Communicate Names Options Tags Zoom Ink ~
Full Name...
Company
Job title
File as -
Internet
EE E-mail... -
Display as Notes

Web page address
IM address

Phone numbers

Business... -

Home... -

Business Fax... -

Mobile... -
Addresses

Business... -

This is the mailing
address
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Contact Group (also referred to as “mailing
lists” or “mail groups™) can be created in

Send / Receive

Folder View

To populate the list, you either choose:

e Select Members...
e Add New...

2- -

Contact Group Insert Farmat Text Review

1 B

& kg g

I =y o Outlook by clicking the arrow to the right of
I::| ) &:“ .:.':I 3< MDD N}" as| the “New Items” button and choose “Contact
ew ew Contact lew elete eetin are
Contact  Group ltems = 7 0° Pl Group” from the menu that appears.
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4My Contacts FE Appointment :—E]
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to pick existing contacts already in your address book.
to type in email addresses directly.

ENI-Power Partners - Contact Group

E‘Dhl’

[2-] beth@migneneconstruction.com
[5] Brandon Steinberger

[E5] Brian McCabe

[25] David Mevins

[25] ddicpa@optonline.net

[25] Dexter Ross (rossfive@earthlink.net}
[25] Elyse Arkind

[25] Erick Weinstein

[25] forsalebymarcia@aol.com

[25] Glenn Haas (glenn@ablefireny, com)
[25] gol4dds@acl.com

[25] Jann Trefny

[25] Jay Dubin

[25] jeffrey.kussoy@axa-advisors.com
[25] Kate Ryan

[25] kfrey@pbipayroll.com

[25] kfrey4995@verizon.net

[25] kglass@tmccompany.com

[25] larry@movingahead.com

[25] Lisa Gardner

[5] marc Arkind

[25] Paul R Montenera

[25] removeitman@aol.com

[25] Russell Irushalmi

[25] Russell Irushalmi

[25] Ted Kramer

[25] Tim Mulgueen timmystowing@aol.com)

Save & Delete Forward Members Motes Add Remove Update Email Meeting Categorize Follow Private Zoom
Close Group Group - Members ~ Member Mow - Up~

Actions Show Members Communicate Tags Zoom
Name ‘BN\—PowerPartners
D Mame - E-mail

beth@mignoneconstruction.com
sales@signsofbusiness.com
bmeccabe@mtb.com
dnevins@dcnlaw.com
ddlepa@optonline.net
rossfive@earthlink.net
elyse@alpineadvantagepartners.com
eweinstein@cardworksacquiring.com
forsalebymarcia@aol.com
glenn@ablefireny.com
goMdds@aol.com
Jann.trefny@mssb.com
jay.dubin@morganstanley.com
Jjeffrey.kussoy@axa-advisors.com
kate @krpcfamilylaw.com
kfrey@phipayroll.com
kfrey4895@verizon.net
kglass@tmccompany.com
lary@movingahead.com
lisa@3A-Travel.com
marc@alpineadvantagepartners.com
paulr@clearcutcomputing. com
removeitman@aol.com
rirushalmi@yahoo.com
rirushalmi@guardhill.com
Ted@LDLonglsland.com
timmystowing@aol.com

Printing contacts

Outlook provides for many printing options designed to allow those people who like to
carry paper address books with them. From the tabs on top of the screen, click File
and then choose Print. Many arrangements of the contacts are available.
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